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1) PURPOSE 
 

Personnel and equipment will be demobilized from the incident in accordance with this plan. 
Demobilization is an orderly and cost effective process for the release and return of all response 
resources and personnel to their respective home destinations.  The demobilization of resources 
and personnel from this incident will involve all personnel working on the incident.  This 
demobilization plan will be implemented upon approval of the Incident Commander (IC). 
 
This plan is a living document and may be modified as necessary, as a result of changing site 
conditions and/or any additional factor as determined by the IC. 
 
 
2) OBJECTIVES 

 
a) Demobilization of personnel is critical in future planning for the response organizational 

structure. Prioritization of demobilization is conducted to ensure that all incident 
command priorities are addressed and the response organization remains intact to ensure 
that all incident objectives are achieved. 
 

b) Resources, including personnel, no longer required for the response will be demobilized 
as rapidly as is feasible.  Generally, demobilization of personnel will occur from the 
Group/Unit level, to the Branch Director level, to the Section Chief and Command staff 
level. 
 

c) The IC has delegated authorization for the demobilization of individual personnel to the 
joint approval of the Operations Section Chief (OPSC) and the Planning Section Chief 
(PSC). 

 
d) Demobilization Check-Out Form (ICS 221 A Form, Attachment C) will be used to 

facilitate the process and to provide resource accountability.  As resources are identified 
which are available for demobilization, the ICS 221 A Form will be initiated by the 
Section Chief responsible for that resource. The ICS 221 A Form will be reviewed by the 
OPSC and the PSC to verify that the resource is not planned for another task.  After their 
approval and concurrence from the IC, the resource will be demobilized from the 
incident.  
 

e) The PSC will be responsible for distribution of information of released resources to other 
sections. 
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3) TASKS TO BE COMPLETED PRIOR TO DEMOBILIZATION 
a) Each Section Chief has identified a list of critical tasks which shall be completed prior to 

demobilization of the respective unit from the incident. 
 
i) Command Staff 

 
(1) Incident Commander 

(a) Submit all hard copy documentation, electronic documentation, and e-mails in 
accordance with procedures outlined in Attachments A and B of this 
document. 

 
(2) Deputy Incident Commander 

(a) Submit all hard copy documentation, electronic documentation, and e-mails in 
accordance with procedures outlined in Attachments A and B of this 
document. 

 
(3) Safety Officer 

(a) Coordinate with MDEQ to develop and implement a schedule for transition of 
all Safety Officer tasks to MDEQ. 

(b) Provide support services, as necessary, during transition of the Safety Officer 
position to MDEQ. 

(c) Submit all hard copy documentation, electronic documentation, and e-mails in 
accordance with procedures outlined in Attachments A and B of this 
document. 

 
ii) Operations Section 

(a) Transition all necessary Operations field oversight positions to MDEQ, 
including sufficient overlap period. 

(b) Transition all necessary Operations Group Supervisor/ Division Lead/ Field 
Team Lead positions to MDEQ, including sufficient overlap period. 

(c) Transition Deputy Operations Chief and Operations Chief positions to MDEQ 
including sufficient overlap period. 

(d) Complete review of all outstanding Operations documents submitted to U.S. 
EPA by Enbridge, including but not limited to, the following: 
(i) Overbank Response Action Summary Reports 
(ii) Shoreline and Overbank Reassessment Techniques Summary Reports 
(iii)Submerged Oil Reassessment Summary Reports 
(iv) Monthly Progress Reports 
(v) Any Addendum documents submitted to the December 21, 2011 

Consolidated Work Plan (CWP). 
(e) Review the CWP to identify any tasks that have not been completed and 

schedule these tasks within the Unified Command for completion. 
(f) Complete After Action Modular Summary Report. 
(g) The Waste Management Branch shall complete the following activities: 

(i) Ensure electronic copies of all manifests are properly maintained, based on 
review of Waste Manifest Tracking Log, the Enbridge Monday’s Totals 
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Report (Recovered Oil Report), and Enbridge’s monthly reports. 
(ii) Ensure electronic copies of all waste analytical laboratory reports are 

properly maintained, based on review of Enbridge’s Equis database, the 
Enbridge Monday’s Totals Report (Recovered Oil Report), and Enbridge’s 
monthly reports. 

(iii)Complete 100% QA/QC of Enbridge’s Monday’s Total Report (Recovered 
Oil Report) 

(h) Ensure that all routine Operations generated documents, files, etc. have been 
tracked, filed, and submitted to the Documentation Unit, including but not 
limited to: 
(i) Operations ICS 214 forms 
(ii) Digital photos and associated photo tracking sheets 
(iii)Logbooks 

(i) Submit all hard copy documentation, electronic documentation, and e-mails in 
accordance with procedures outlined in Attachments A and B of this 
document. 

 
iii) Logistics Section 

(a) Equipment  
(i) EPA-owned Equipment 

1. Inventory 
2. Reconciliation in coordination with EPA Regional Logistics staff 
3. Determination of current and projected needs 
4. Demobilization of items determined unnecessary during Step (i)(3) 

above. 
5. Documentation of the demobilization 

(ii) START Contractor-owned Equipment 
1. Inventory 
2. Reconciliation in coordination with START warehouse staff 
3. Determination of current and projected needs 
4. Demobilization of items determined unnecessary during Step (ii)(3) 

above. 
5. Documentation of the demobilization 

(iii)Enbridge-owned Equipment 
1. Inventory 
2. Reconciliation based on 213 Records 
3. Determination of current and projected needs 
4. Return items determined unnecessary during Step (iii)(3) above to 

Enbridge. 
5. Documentation of the return 

(b) Begin consolidation of personnel into reduced number of trailers.  Once 
consolidation is complete, coordinate with Enbridge regarding removal of 
excess trailers. 
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(c) IT Equipment 
(i) START-Contractor Server 

1. Ensure all appropriate documents have been submitted to the EPA 
server for processing. 

2. Coordinate with START-Contractor IT support regarding appropriate 
backup 

3. Demobilization 
(ii) EPA-server 

1. Coordinate with the Planning/Documentation Unit to ensure all 
documents are processed and appropriate back-ups have occurred. 

2. Coordinate with EPA Regional Logistics staff to schedule return of the 
server to the EPA regional office. 

3. Demobilization 
(d) Submit all hard copy documentation, electronic documentation, and e-mails in 

accordance with procedures outlined in Attachments A and B of this 
document. 

 
iv) Planning Section 

 
(1) GIS Unit 

(a) Obtain a complete backup of all GIS data maintained by Enbridge. 
(b) Ensure PDF files of all created maps have been submitted to the 

Documentation Unit, in the proper format. 
(c) Coordinate with Logistics to return equipment (plotter, GIS computer, ink). 
(d) Send backup of the GIS portion of the server to the Weston Chicago office 

contract files. 
(e) Submit all hard copy documentation, electronic documentation, and e-mails in 

accordance with procedures outlined in Attachments A and B of this 
document. 

 
(2) Documentation Unit 

(a) EPA Documentation Unit 
(i) Perform a comprehensive audit/reconciliation of all enforcement related 

documents, including EPA Order, directives, letters, and Enbridge plans 
and reports.  This audit shall ensure that all EPA directives have been 
fulfilled, and that all Enbridge plans/reports have received formal 
response.  Forward any outstanding items to the Environmental Unit 
and/or Operations for review and response. 

(ii) Collect all hard copy documentation from demobilizing personnel for 
processing. 

(iii)Ensure all submitted documents are properly signed and dated by the 
demobilizing personnel. 

(iv) Collect all electronic documents from demobilizing personnel, including 
archive files of all site-related e-mails. 

(v) Process all received documentation in accordance with the Documentation 
Unit Standard Operating Procedure. 
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(b) START Contractor Documentation Unit 
(i) Reconcile START server for missing documents.  Scan any missing 

components. 
(ii) Reconcile EPA server with the START server and transfer any missing 

documents to the EPA server. 
(iii)Finalize Logbooks 

1. Once all field work is complete, complete the covers of all log books 
from the first day of the response to the final documented day, by 
assigning final book number to all books. 

2. Re-scan the covers of all finalized logbooks and merge with existing 
scan of the logbook. 

3. Reconcile all completed logbooks with EPA server 
4. Upload  all completed logbooks to Weston FTP site 

 
(3) Situation Unit 

(a) Continue documenting and updating the OPSC on all transitional progress and 
continually changing field conditions throughout the transitional period. 

(b) Assist in all photo-documentation and metrics reporting required for 
completion of the After Action Report. 
 

(4) Environmental Unit 
(a) Complete and submit final review comments to Enbridge regarding the 

Hydrodynamic Model (HDM) Calibration Report; comments shall include a 
list of data gaps to be addressed in order to complete HDM model calibration. 

(b) Review additional data collection procedures, data results, and baseline model 
run results performed in order to complete the HDM model calibration. 

(c) Develop a final list of additional model scenarios to be completed using the 
calibrated HDM, or suitable subarea models, in order to demonstrate adequate 
understanding of submerged oil transport and deposition within critical 
portions of the Kalamazoo River system, per the CWP.  As described in the 
CWP, additional model scenarios may include, but are not limited to:  repeat 
model runs that incorporate additional categories of low-density sediments 
representing organic sediments and/or submerged oil, a detailed 3D model of 
the Delta and Morrow Lake (e.g., from 35th Street bridge to Morrow Lake 
dam; summer and winter conditions), a 2D or 3D model of the new E-4 
containment system, detailed 2D models of select sediment trap areas that 
represent the effects of sediment removal and/or trap deepening.  Any data 
needs for the additional model scenario runs would also be specified. 

(d) Review of additional data collection procedures, data results, and model 
results obtained in order to complete the required HDM model scenarios. 

(e) Assist in developing final data collection procedures for performing the 2012 
submerged oil quantification evaluation.  Review data collection, results, and 
submerged oil quantification calculations and reporting. 

(f) Assist in developing final data collection procedures for performing the 
submerged oil agitation effects evaluation.  Review data collection, results, 
and report documentation for the submerged oil agitation effects evaluation. 
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(g) Review all outstanding Enbridge plans and/or reports identified by the 
Documentation Unit in Section 2(a)(1) above. 

(h) Submit all hard copy documentation, electronic documentation, and e-mails in 
accordance with procedures outlined in Attachments A and B of this 
document. 

 
v) Scientific Support Coordinators (SSCs) 

(a) Review all recommendations prepared by SSCs and submitted to the FOSC. 
(b) Identify all SSC recommendations that the FOSC forwarded to Enbridge for 

implementation. 
(c) Review all final work plans and final reports to ensure that SSC-recommended 

tasks have been completed, to include: 
(i) Development of oil fingerprinting procedure for submerged Line 6B oil. 
(ii) Volume estimate for residual Line 6B submerged oil. 
(iii) Biodegradation of Line 6B oil, both evidence for current biodegradation 

and potential for future biodegradation.  
(iv)  Toxicity testing of spill site sediments. 
(v)  Dose/response testing for Line 6B oil. 
(vi)  Study documenting effects of sediment agitation on residual Line 6B oil, 

including potential for adverse ecological effects and behavior of oil 
introduced into the water column. 

(vii) Additional tasks that may be recommended by the SSC and ultimately 
forwarded to Enbridge by the FOSC. 

(d) Collect documentation for all SSC Group activities, limited to materials 
prepared or received by internal coordination staff: 
(i) Meeting minutes 
(ii) Workshop minutes 
(iii) Electronic documentation 
(iv)  E-mails 
(v) All reference documents uploaded to the SSC Group shared webpage. 

(e) Submit all hard copy documentation, electronic documentation, and e-mails in 
accordance with procedures outlined in Attachments A and B of this 
document. 
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4) DEMOBILIZATION OF PERSONNEL. 
a) All releases of personnel will be initiated in the Resources Unit after approval from the 

OPSC and PSC, and concurrence with the IC. 
b) All Section Chiefs will coordinate demobilization of staff with the PSC, OPSC, and 

Resources Unit Lead. 
c) No units, personnel or equipment will leave the incident until authorized to do so. 
d) All equipment checked out must be returned to the Logistics Section. 
e) All demobilizing personnel must complete the ICS 221 A Form and receive sign-off from 

the following:  
(1) OPSC  
(2) PSC 
(3) Logistics Section Chief 
(4) Documentation Unit Lead 

f) All demobilization activities will be accomplished in the safest and most cost effective 
manner.  No person will be released prior to obtaining a minimum of eight (8) hours of 
rest, unless specifically approved by the IC or their designee. 

g) Upon safe arrival at home unit, all personnel must email the Resources Unit.  
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Attachment A – Instructions for Submitting Site Documentation to the 
Documentation Unit 

1) PREPARING HARD COPY DOCUMENTS FOR SUBMITTAL 
a. Separate all hard copy documentation as follows: 

i. Clean copies of documents. 
ii. Documents containing alterations (i.e. hand written notes, highlighting, starring 

or any other markings). 
b. All copies of documents containing alterations should include the following in the upper 

right hand corner of the document (space permitting): 
i. Name of individual who made the alteration. 

ii. Signature of individual who made the alteration. 
iii. ICS position of the individual who made the alteration, at the time the alteration 

was made. 
iv. Date the alteration was made. 
v. Identify partial documents (i.e. missing Page 3 of 10) by writing the phrase 

“Partial Document” under the date the alteration was made. 
 

2) ELECTRONIC FILES 
a. Create 3 folders on an external hard drive or thumb drive for transfer of files to the 

Documentation Unit: 
i. “EOS-FILES-UNALTERED- NAME-POSITION”:  This folder should contain 

files which were distributed to you by a different individual, maintained in your 
possession, but not altered in any way by you.  The file name and modified date 
should be identical as when you received it. (i.e. Daily distribution of metrics 
reports from Enbridge, which were viewed by you, but not modified.) 

ii. “EOS-FILES-EDITED- NAME-POSITION”:  This folder should contain files 
which were created by a different individual, but modified or edited by you.  (i.e. 
a SitRep which was reviewed by you and contains your edits, via track changes 
or within the text.) 

iii. “EOS-FILES-AUTHORED- NAME-POSITION”: Files which you authored.  
The file name of final versions should begin with “Final_”.  Draft and working 
copies should begin with “Draft_”.  

 
Where the above naming convention is as follows: 
NAME – Last Name followed by First Name with no space 
POSITION – ICS Position held during the date range of the e-mails included in 

PST (i.e. LSC for Logistics Section Chief, DOPSC for Deputy 
Operations Section Chief, etc.) 

b. Burn copies of all electronic files stored locally on your computer or alternative media, 
including but not limited to, external hard drives and thumb drives.  Save all copies in the 
appropriate folder created in Step (a) above. 

c. Submit all DVDs and CDs as received.  Do not save copies of the contents to the above 
folders. 
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3) MEET WITH DOCUMENTATION UNIT 

a. On-Site Personnel 
i. Coordinate with the Documentation Unit Lead to arrange a time to submit all 

hard copy and electronic documents. 
ii. During this meeting, the Documentation Unit Lead will go through all documents 

you are submitting and will return your thumb drive or external hard drive. 
b. Off-Site Personnel 

i. Make copies of all hard copy documentation and electronic files prepared in 
Steps 1 and 2 above.  Maintain these copies until the Documentation Unit Lead 
contacts you to indicate that the originals were received. 

ii. Mail or FedEx all ORIGINAL hard copy documentation prepared in Step 1 
above and a thumb drive or external hard drive containing all  electronic files 
prepared in Step 2 above to the following address: 

EPA Documentation Unit 
1601 Pratt Avenue, Trailer 9 
Marshall, MI 49068 
 

iii. Contact the Documentation Unit Lead to advise them of the documents you are 
submitting. 

iv. Thumb drives and/or external hard drives will not be returned.  If you prefer 
to not send a thumb drive or external hard drive, please contact the 
Documentation Unit for instruction on how to upload your documents to an FTP 
or to arrange for an alternative submittal process. 

 

  



 

Demobilization Plan – Version 1.0 Page 10 
 

Attachment B – Instructions for Submitting E-mails to the Documentation 
Unit 

1) CREATING A PST USING MICROSOFT OUTLOOK 2010 
a. Identify the date of the first e-mail you received relating to the Enbridge Oil Spill.  

Identify the date of the most recent e-mail you will be submitting.  Write both of these 
dates down.  They will be used in Step (i) below to name your PST. 

b. Open Microsoft Outlook. 
c. Select the “File” tab 
d. Select “Info” on the right side of the  
e. Select the “Account Settings” dropdown button 
f. Select “Account Settings…” 

 

 
g. Select the “Data Files Tab” 
h. Select “Add” – A popup menu will appear prompting you to enter a name for your new 

PST 
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i. Name your PST using the following naming convention:  
 
EOS-EMAILS-XXXXXXXX-YYYYYYYY-NAME-POSITION 
 
Where the above naming convention is as follows: 
XXXXXXXX – Date of First E-mail included in PST in format YYYYMMDD 
YYYYYYYY – Date of Last E-mail included in PST in format YYYYMMDD 
NAME – Last Name followed by First Name with no space 
POSITION – ICS Position held during the date range of the e-mails included in 

PST (i.e. LSC for Logistics Section Chief, D OPSC for Deputy 
Operations Section Chief, etc.) 

j. Select the “Home” Tab of Microsoft Outlook.  
k. Your new PST will appear on the gray bar on the right side of the screen. 

 
l. Drag and drop ALL Enbridge related e-mails (including mobilization orders, e-mails you 

were CCed on, both send and received e-mails, etc.) into the PST. 
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2) SUBMITTING THE PST TO THE DOCUMENTATION UNIT 

a. Once all e-mail have been moved or copied into the PST, select the “File” tab. 
b. Select the “Account Settings” dropdown button 
c. Select “Account Settings…” 
d. Select the “Data Files” Tab 
e. Follow the file path shown in the “Location” column associated with your Enbridge PST 

to locate the PST file. 

 
f. Copy the file to a thumb drive or burn it to a CD and submit to the Documentation Unit. 

 
3) ADDITIONAL CONSIDERATIONS 

a. If you have any e-mails sent to an e-mail account other than ones included in your 
Outlook files, (i.e. a personal, web-based e-mail provider), please consult with the 
Documentation Unit.  Do not just forward these e-mails to your primary account. 

b. If you use different e-mail management software (i.e. Lotus Notes), please create an 
archive file (i.e. .NST file), using the naming convention described in Section 1(g) of this 
document.  Consult with the Documentation Unit for additional assistance. 
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Attachment C – ICS Form 221A 
 



ID Task Name Start Finish

1 Safety Officer Mon 7/23/12 Thu 8/30/12
2 Develop a schedule for transition to MDEQ Mon 7/23/12 Tue 7/31/12
3 Provide support services during transition of the Safety

Officer position to MDEQ
Tue 7/31/12 Thu 8/30/12

4 Submit all hard copy documentation, electronic
documentation, and e-mails

Mon 7/23/12 Thu 8/30/12

5 Operations Tue 7/17/12 Fri 9/28/12
6 Prepare schedule for transition of all necessary Operations

personnel to MDEQ
Mon 7/23/12 Mon 7/30/12

7 Transition all necessary Operations field oversight
positions to MDEQ

Wed 8/1/12 Thu 8/30/12

8 Transition all necessary Operations Group Supervisor/
Division Lead positions to MDEQ

Wed 8/1/12 Fri 9/14/12

9 Transition Deputy Operations Chief and Operations Chief
positions to MDEQ

Wed 8/1/12 Fri 9/28/12

10 Complete review of all outstanding Operations documents
submitted to US EPA by Enbridge

Mon 7/23/12 Fri 9/28/12

11 Review CWP to identify any tasks that have not been
completed and schedule for completion

Tue 7/17/12 Wed 7/18/12

12 Complete After Action Modular Summary Report Mon 7/23/12 Fri 9/28/12
13 Submit all hard copy documentation, electronic

documentation, and e-mails
Mon 7/23/12 Fri 9/28/12

14 Waste Management Branch Mon 7/23/12 Thu 8/30/12
15 Ensure electronic copies of all manifests are properly

maintained
Mon 7/23/12 Mon 7/30/12

16 Ensure electronic copies of all waste analytical laboratory
reports are properly maintained

Mon 7/23/12 Fri 8/10/12

17 Perform 100% QA/QC of Enbridge’s Monday’s Total
Report (Recovered Oil Report)

Fri 8/10/12 Thu 8/30/12

18 Logistics Mon 7/23/12 Fri 9/28/12
19 Inventory of equipment Mon 7/23/12 Tue 7/31/12
20 Reconciliation of equipment Wed 8/1/12 Tue 8/7/12
21 Determination of current and projected needs Wed 8/8/12 Tue 8/14/12
22 Demobilization of items determined unnecessary Thu 8/16/12 Fri 9/28/12
23 Consolidation of personnel into reduced number of trailers Wed 8/1/12 Tue 8/14/12

24 Demobilization of the START server Fri 9/28/12 Fri 9/28/12
25 Coordinate with EPA Regional Logistics staff to schedule

return of the server to the EPA regional office
Mon 9/24/12 Thu 9/27/12

26 Demobilization of the EPA server Fri 9/28/12 Fri 9/28/12
27 Submit all hard copy documentation, electronic

documentation, and e-mails
Mon 7/23/12 Fri 9/28/12

28 EPA Documentation Unit Mon 7/23/12 Fri 9/28/12
29 Perform a comprehensive audit/reconciliation of all

enforcement related documents
Wed 8/1/12 Fri 9/14/12

30 Collect all hard copy documentation from demobilizing
personnel for processing

Mon 7/23/12 Fri 9/28/12

31 Ensure all submitted documents are properly signed and
dated by the demobilizing personnel

Mon 7/23/12 Fri 9/28/12

32 Collect all electronic documents from demobilizing
personnel

Mon 7/23/12 Fri 9/28/12

33 Process all received documentation Mon 7/23/12 Fri 9/28/12
34 START Contractor Documentation Unit Mon 7/23/12 Fri 9/28/12
35 Reconcile START server for missing documents  Rescan

any missing components
Mon 7/23/12 Fri 8/31/12

36 Transfer/reconcile EPA server for missing documents Wed 8/15/12 Fri 9/14/12

37 Finalize Logbooks Mon 9/17/12 Fri 9/28/12
38 Environmental Unit Mon 7/23/12 Fri 9/28/12
39 Submit final review comments to Enbridge regarding the

HDM Calibration Report
Mon 7/23/12 Fri 8/10/12

40 Review additional HDM data collection procedures, data
results, and baseline model run results

Fri 8/10/12 Fri 8/24/12

41 Develop a final list of additional model scenarios to be
completed using the calibrated HDM

Mon 8/27/12 Fri 9/7/12

42 Review of HDM model scenarios additional data collection
procedures, data results, and model results

Mon 9/24/12 Fri 9/28/12

43 Submit all hard copy documentation, electronic
documentation, and e-mails

Mon 7/23/12 Fri 9/28/12

44 Situation Unit Mon 7/23/12 Fri 9/28/12
45 Updating the OSC on transitional progress and changing

continual changing field conditions
Mon 7/23/12 Fri 9/28/12

46 Photo-documentation and metrics reporting required for
completion of the After Action Report

Mon 7/23/12 Fri 9/28/12

47 Scientific Support Coordination (SSC) Mon 7/23/12 Thu 8/30/12
48 Review all recommendations prepared by SSCs and

submitted to the FOSC
Mon 7/23/12 Mon 7/30/12

49 Identify all SSC recommendations that the FOSC
forwarded to Enbridge for implementation

Mon 7/23/12 Mon 7/30/12

50 Ensure that SSC-recommended tasks have been
completed

Tue 7/31/12 Thu 8/30/12

51 Collect documentation for all SSC Group activities Mon 7/23/12 Thu 8/30/12
52 Submit all hard copy documentation, electronic

documentation, and e-mails
Mon 7/23/12 Thu 8/30/12

S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S S M T W T F S
Jul 15, '12 Jul 22, '12 Jul 29, '12 Aug 5, '12 Aug 12, '12 Aug 19, '12 Aug 26, '12 Sep 2, '12 Sep 9, '12 Sep 16, '12 Sep 23, '12

Task Split Progress Milestone Summary Project Summary External Tasks External Milestone Deadline
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